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:HOFRPH�7R�(DV\�3&�)RU�:LQGRZV
This is a brief guided tour of the evaluation version of our latest Schematic and PCB design tool, Easy-PC
For Windows. The evaluation version is a fully functional version of the program without the ability to save
your designs, and with the Pen-plotter, Gerber and Excellon N.C. Drill file outputs disabled (although you
can see the dialogs which are used to control the outputs. There are no time limits on this evaluation and
it can be removed at any time using the Windows [Add / Remove Programs] mechanism in the [Control
Panel].

The evaluation program combined with this document will allow you to use all of Easy-PC's functionality
whilst being guided through the basics of the system and it's capabilities.

Easy-PC really is the latest generation of PCB CAD with no other product currently as advanced or in-line
with the Microsoft operating systems - Windows 95/98 and NT. And because Easy-PC has been written
using the latest software techniques, object oriented code (C++) and under Windows NT as a true
Windows 32 bit application, it can be easily enhanced to accommodate new demands in technology and
customer feedback.

+DUGZDUH�5HTXLUHPHQWV
Easy-PC doesn't require special or 'high powered' hardware to run on. A fast 486 or a Pentium processor
machine is suitable provided is has enough spare disk space to load Easy-PC (about 25Mb is required),
and enough RAM to ensure that Easy-PC isn't being paged in and out of memory, so about 20Mb
minimum* for the evaluation is ok. For the fully functional Easy-PC product you would probably need
about 32Mb minimum of RAM to get the best performance out of the application. The evaluation runs
happily on Windows 95™ , 98™ and NT4.0™ but cannot run on Windows 3.1x - sorry! A CD-ROM and
mouse drive are also required to load and operate it.
���0E�LV�UHTXLUHG�WR�XVH�:LQGRZV�������ZLWKRXW�VLJQLILFDQW�SHUIRUPDQFH�GHJUDGDWLRQ�
,QVWDOODWLRQ�2I�7KH�(YDOXDWLRQ�6RIWZDUH
6\VWHP�6HWXS���,QVWDOODWLRQ�IURP�&'�520
To install the evaluation version of Easy-PC For Windows, first ensure that all other applications have
been closed, and relevant data saved.

Insert the CD-ROM into the CD drive and wait for a short time. The default setup of Windows 95/98 and
NT enables the DXWRUXQ facility to be automatically used. If your system has the autorun facility disabled
or it simply hasn't worked, select [Run] from the [Start] menu, and type D:\setup.exe (replacing the D: with
the actual CD drive letter, if necessary, then <Enter>.

The Easy-PC For Windows Setup screen will now provide you with a number of choices for installation of
products and for various utilities.

A Setup screen is now displayed, select the 'Install Easy-PC For Windows Demonstration' option and
follow the instructions on the preceding screens.

If at any time you click on [Cancel], the window that appears gives you the chance to Continue or Exit the
installation.

When the CD has been copied, messages will briefly display indicating that registry entries have been
created, and icons copied. The selected folder will appear briefly as the icons are added, then a 'Setup
Complete' window appears. You can choose whether to immediately launch the program, but in any case,
the final step is to click on [Finish] to complete the installation.
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6\VWHP�/LPLWV
:KDW�/LPLWV�"
Apart from maximum board size of 1m x 1m, there are 12�/,0,76 to any of the major design parameters.
No component limits, No pin count limits, No net count limits, No layer limits, No track width limits and No
pad dimension limits, basically the system is virtually unlimited.

When creating even the very largest designs, adding more memory to your computer immediately
increases the capacity but not to unrealistic levels. Some of the largest designs we have in the software
development centre will load into a 'standard' Multi-media PC bought in the high street.

Easy-PC operates with 12�'RQJOH or other hardware protection (although it is protected using an
authorisation code).

Easy-PC is a flexible and dynamic system. Because at Number One Systems we understand that not all
designers have the same budget or same design requirements, we've created a number of product
variants which will appeal to all pockets. These variants (except for Schematics only) have exactly the
same functionality but are restricted to the number of component pins* allowed in the PCB design.

Easy-PC For Windows product variants include an Unlimited, 2000, 1000 and 500 pin limited variants*.
This gives you the ability to choose the right product to suit your budget or design requirements. There is
also a Schematics only version of Easy-PC For Windows available which can be used to drive one of our
simulators or other PCB design packages.
�&RPSRQHQW�SLQV�PHDQV�WKH�SDGV�RQ�D GHYLFH�SODFHG�RQ�WKH�3&%�GHVLJQ�H�J��WZR����SLQ�',/V�SODFHG�RQWKH�GHVLJQ�FRQVWLWXWHV���[����SLQV� ����XVHG�FRPSRQHQW�SLQV��7KLV�OLPLWHG�GRHV�QRW�LQFOXGH�YLDV�EXW�GRHVLQFOXGH�IUHH�SDGV�DQG�607�SDGV�
In addition to the PCB and Schematic design products and autorouter, there is also a range of analogue,
digital and electromagnetic simulators available. Also complementing the electronics design portfolio are
a filter design package, a software implementation of the paper Smith chart developed by Bell labs, and a
stock and kitting control program.

8VHUV�2I�3UHYLRXV�'26�9HUVLRQV�2I�(DV\�3&
The evaluation version allows you to ORDG��HGLW�DQG�SULQW�RXW�on Standard Windows Printers, this
includes the evaluation files and files created using the original DOS programs: EASY-PC, EASY-PC
Professional and EASY-PC Professional XM. Once imported, these files can be temporarily edited but not
saved. They can, of course, be saved with the full version of the program.

The Full version of Easy-PC for Windows also enables you to import and use components and
component libraries that have been created with EASY-PC DOS, EASY-PC Professional or EASY-PC
Professional XM. Old designs can be fully supported, maintained and developed with the new Easy-PC.

Remember, Number One Systems are the only CAD company who can fully read old Easy-PC designs
and libraries without any effort at all. This feature alone saves valuable time taken creating and checking
libraries, while designs retain 100% integrity in the new software, giving you confidence that your
intellectual property is totally secure and maintainable.

:KDW
V�1HZ�,Q�7KH�/DWHVW�9HUVLRQ�2I�(DV\�3&�)RU�:LQGRZV�"
Like all software products, Easy-PC For Windows' development is moving at an incredibly fast pace. To
make this guide more focused on your objectives - actually evaluating our product, we've put a
description of all the latest changes into both the on-line help and into a file ( NewIn[[.wri) which can be
accessed through the DXWRUXQ Welcome screen or by locating it from the taskbar [Start] [Programs]
[Number One Systems] folder. From this folder simply double click on its filename to view the file.
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*HWWLQJ�6WDUWHG
This manual is intended to take you on a short journey through the main features of Easy-PC For
Windows. It is not intended as a training course but is intended to give to a 'taste' of some of the powerful
features in the product and to get to started so that you can explore further features which are of
particular interest to you.

We recommend that you print out this manual before starting to run the software. You will then be able to
compare the printed instructions with the information on the screen without having to keep switching tasks
all the time.

As this evaluation version does not allow you to save your work as you proceed, we have provided a
number of example files representing different stages of the design process. These can be loaded at any
point if you want to take a break and come back to the program later or if you lose your way!

6WDQGDUG�,QVWDOODWLRQ�)ROGHU
As we explained at the beginning of this manual, and during the installation, the evaluation version of
Easy-PC for Windows will install by default into C:\Program Files\Number One Systems\Easy-PC. Other
folders are created underneath this for example files and libraries, ' ([DPSOHV
 and '/LEV
 respectively.

5XQQLQJ�7KH�(YDOXDWLRQ�6RIWZDUH
To start this evaluation you first need to run up the program. Click on the
[Start] button on the Windows taskbar (along the bottom of your screen).
Select [Programs] [Number One Systems] and [Easy-PC Demo]. The
application will now start running, wait a short time for it to fully load, this only takes about 10 seconds
normally. Easy-PC is now ready to use. Incidentally, if you are familiar with the Windows 95 operation it is
more efficient to create a shortcut on your desktop to Easy-PC especially if our program is one you use
regularly.

Easy-PC uses the standard Windows graphical user interface conventions. The main menu items are
arranged across the top of the window, with a set of toolbar buttons immediately below them. Simply
placing the cursor over any menu item or toolbar button will display a brief description of its function on
the status bar at the bottom of the window (called a 'tooltip').

This manual assumes that you are familiar with the main Windows operations and terminology.

It is also important to understand that Easy-PC For Windows has been strictly written using Microsoft
standards which means that wherever possible menu items for 'common' commands or functions appear
in the same place whether you're using Microsoft Word or Easy-PC.  Some good examples are
[Undo]/[Redo], [Delete], [Cut], [Copy] and [Paste] which are always located on the [Edit] menu.

/RDGLQJ�$�'HVLJQ
Load any example design file by dropping down the [File] menu and selecting [Open] from the Examples
folder. We suggest the file ' div.pcb' as an uncomplicated example file.

(DV\�3&�,QWHUDFWLRQ���8VLQJ�7KH�,QWHUIDFH
&OLFNLQJ��'RXEOH�&OLFNLQJ�DQG�'UDJJLQJ
Objects are generally selected by single clicking on them, while double clicking usually selects the
appropriate item and performs an operation on it. Single clicking the right mouse button displays a context
sensitive menu in most situations i.e. additional operations relevant to its current mode. For example in
Move you can also Flip (to the other side of the board), Rotate, change Properties etc.
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Double click on a component pin starts a connection or track. Right click whilst adding or editing tracks or
connections gives access to all of the properties and enables you to finish or cancel the operation.
Track and connection stubs can be deleted using right click and selecting delete.

You are given a preview of, and are asked to confirm, all deletions.

Don't forget, if you delete something by accident, you can recover it by using Undo (shortcut: <Ctrl> Z)

(DV\�=RRP�DQG�3DQ
Pressing the [A] key (All) automatically zooms to display the whole design. Place the cursor anywhere in
the design and press the [Z], [U] or [P] keys. Zoom can also be selected using the numeral keys above
the alpha keyboard. Try the Frame zoom option in the View menu -simply select [View], [Frame] then
click and drag the cursor diagonally across an area of the design. This enables you to zoom into the area
defined.

See how the [Z]oom [P]an and [U] nzoom keys work. Press the [A] Key and see how it [A] uto zooms to fill
the screen with the current design. Try [View] [Frame] (or Ctrl F) then drag a box on the screen see how
Easy-PC automatically zooms to make that box fill the screen.

During this you may wish to remove the Grid display from the screen. Simply press the <G> key to toggle
the screen grid on and off.

(DV\�0RYH
Try "Click and Drag" on Components (click on any pad), Connections, Tracks and Text. See how easy it
is to select and move them without having to set an editing mode. Pick the component, and while the
mouse is pressed, drag the component on the screen. See how easily and sensibly the connections move
as you move components, even the tracks move and remain electrically connected.



(DV\�3&�)RU�:LQGRZV���(YDOXDWLRQ�*XLGH

6

(DV\�*URXS�2SHUDWLRQV
Try clicking and dragging a box around a group of components and then moving the complete group
together. Note how objects can be added or subtracted from a group using <Ctrl> Click on that object.

(DV\�&LUFXLW�5H�XVH
Try selecting a group of components and copying it to the clipboard, using <Ctrl> C. Paste it back to
another area of the design, using <Ctrl> V. Notice how all the nets and components are automatically
renumbered to avoid any conflicts. This can be done in SCM or PCB and can be done across sheets or
designs making it very powerful and flexible. It also provides you an instant method for merging designs.

(DV\�([LW
If at any time you get lost or think the program has taken over there are a number of confidence checks
you can make but remember the most important thing is not to press any keys unless absolutely sure!
The first place to always look is at the bottom of the Easy-PC application at the Status bar Properties.
This gives you information about the current mode and the item selected. Another good check is to look
at the Toolbar just below the Menus. If a mode has been selected, such as [Add Track], the [Add Track]
button will be selected. If you press the [Esc] key a couple of times at this point you are put back into the
neutral [Select] mode (which is safe!).

Just a final note of the modes of the program. Easy-PC doesn't do anything drastic or destructive without
prompting for [OK] from you before it does it, in any case Undo is always there (<Ctrl> Z).

:KDW�6KRXOG�<RX�([SHFW�)URP�$�3&%�&$'�6\VWHP�"
As the name suggests, computer aided design (CAD) means exactly that, designing with the aid of the
computer. However, not all CAD systems are the same, and although they can provide you with CAD,
their ease-of-use and operation for the 'human' aspects of the design leaves much to be desired.

This is where Easy-PC For Windows excels itself…

From the very outset of the concept for Easy-PC For Windows, the underlying factor for the development
of the product was easy-of-use and usability for the user, enabling the design to be created with the least
amount of effort in the shortest amount of time with an optimal tool set.

Using the product under the Windows operating environment you should expect to be using 'standard'
Windows operation, such as drag and drop (without selecting a 'mode' first), double click to edit and a
multiple document interface where different Schematics and PCB designs can be edited at the same time
under the same application. Windows print drivers are essential for modern printers, colour printers, ink
and bubble jet printers but still supporting the old faithful dot matrix printer. Windows graphics drivers are
another essential prerequisite for the program to be utilising, no configuration problems and instant
support for the graphics card installed in your PC. This means that if you invest in a high speed graphics
card, Easy-PC For Windows will take advantage of it without any additional operations or setup.

With a modern system, the program should be a true 32 application to take advantage of the operating
system, it must work to much less than .001" (1 thou/mil) to ensure true metric and imperial unit
conversion. This is essential if using metric components or a mix both types. If your existing system can
only work to a .001" precision then expect rounding errors, and incidentally, Easy-PC works to 1/10"
Micron, so there is plenty of expansion room left and a system which can cope with all current and any
predicted new technology !

Enough of the obvious, let's start the process:

7KH�'HVLJQ�3URFHVV
The normal design process is to create a schematic, simulate it, correct any design errors, re-simulate the
design, and then create the PCB design, checking connectivity and clearances as the design progresses.
At any stage throughout the process printouts and status reports can be produced. On completion of the
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PCB design, Photo plot and N.C. drill files (Numerically Controlled) can be produced and sent off to the
board manufacturer. Although if your design process doesn't include Gerber plotting or NC drilling, Easy-
PC is equally at home for other more DIY processes.

6FKHPDWLFV
Let's start the 'traditional' process with Schematics (Easy-PC doesn't need to be used with both it's own
Schematics and PCB programs, you can mix-and-match applications from other vendors as well or use
just Easy-PC PCB and design boards on-the-fly).

Open 'div.sch' using the [Open] icon on the toolbar, the file is located in the 'Examples' folder.

Hint: If you leave the cursor over any of the toolbar buttons for more than a second or so, the small tooltip
label will appear giving you the name of the button.

Press the <A> key to display the complete schematic.

Before attempting to move a component, view the schematic and decide which one to move. Move the
mouse over the component and press the <Z> key to zoom in, press it a couple of times until the
component is bigger. You can now move the component by clicking anywhere inside its periphery RU on
one of its connection pins and dragging it to a new position. Note how moving a component automatically
takes all of its connections and text with it - sensibly and neatly.

0XOWLSOH�:LQGRZV
Easy-PC can open many designs simultaneously, including a mix of both PCBs and Schematics. The
number is limited only by memory.  This means many schematic design sheets for a project can be
opened along with the corresponding PCB design and the library editors, all in the same application at the
same time!!
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0XOWL�6KHHW�6FKHPDWLFV�DQG�3URMHFWV
Designs can be project based and use multi-sheet
schematics. This means that complex designs can be
spit up into conveniently handled easily understood
subsections. All the sheets in a schematic and the
PCB can be open simultaneously using multiple
windows as described above. The files are then all
'grouped' together during Translate To PCB
automatically to create one PCB design.

$GGLQJ�&RPSRQHQWV�WR�WKH�6FKHPDWLF
Components can be added by selecting the [Add
Component] button on the toolbar. Then select the required
component from one of the available libraries (Hit: the
browse button in the Add Component dialog to see the demo
libraries). Or, if a similar component already exists in the
design, by selecting a similar component, right clicking and
selecting duplicate from the context menu (use the <D> key).

&RPSRQHQW�3URSHUWLHV
While a component is selected, you can right click on it to
display the popup menu and inspect or modify any of the
component’s properties including resistance, capacitance
values etc. Note that the PCB package (Footprint) is

specified at
schematic stage
ready for transfer
into the PCB
design editor. This
component,
Schematic Symbol and PCB Symbol relationship enables an
integrated library to be created which saves both costly errors
and time trying to correlate the transition between Schematics
and PCB where the design moves from 'logical' to 'physical'. It's
also important because of the integrated design environment
with both Schematic and PCB design editors co-existing in the
same application.

6FKHPDWLF�&RQQHFWLRQV
Connections in a schematic can be edited and moved in a similar way to components. Simply click and
drag on any connection and it moves where you want it.

Editing existing connections is all done by clicking and double clicking. Single click on a line segment and
move the mouse to drag it at right angles to its length. Double clicking on a line segment inserts a new
corner. Single clicking on a corner selects the corner so that it can be dragged to a new position. By
clicking on the right hand mouse button while editing connections you can change many entities of the
connection. This includes the actual editing mode itself. What this means is that the segment editing
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mode can be switched from 90
o

right angles to one of 45
o

angles as well. Click on [Segment Mode] from
the right hand context menu and select another mode. You will notice the mode change when adding
corners to the connection.

$GGLQJ�&RQQHFWLRQV�7R�$�6FKHPDWLF
Connections can be added by selecting the [Add Connection] button from the toolbar. Left click on an
existing connection and take the connection over to end at the target terminal of the component clicking
on arrival. Single clicking while adding puts a bend in the connection, don’t worry about making it neat.
Editing is so easy it can be tidied up after the connection is made. If you start your connection at the
component terminal and take it to an existing connection you will be asked if you want to join the nets -
and to confirm the net name. If you've added a connection and ended in the middle of another connection
you will see that a junction point has been added. This large dot differentiates between a connection
actually making connectivity and one just passing over the top.

&RQQHFWLRQ�3URSHUWLHV
While a connection is selected, right click on it to display
a popup menu giving access to the properties of the
connection including the Net Name and Net Class
(select [Change Net]). A Net Class is used to identify the
net type after Translate to PCB to enable track widths
and additional clearances to be applied automatically by
the optional autorouter according to the requirements of
the connection. It also provides the initial track width
when routing manually and a method of categorising
Nets into 'type' groups. Signal tracks would usually be
narrow, Power tracks should be fatter and any high
voltage tracks should have much greater clearances
than low voltage tracks.

6WDUWLQJ�D�1HZ�6FKHPDWLF
In Easy-PC, this begins with the simple process of selecting and placing components and joining their
pins with connections. If you drop down the [File] menu, select [Open] and then select ' LQWUIDFH�VFK
 from
the [File] [Open] dialog.

You will see a fairly complex schematic drawing built up in just this way. (Hit the <A> key to view all of it).
However, in order to concentrate on the essentials, we are going to use a much simpler example.

6FKHPDWLF�7HFKQRORJ\�)LOHV
Close down the window containing ' intrface.sch' and click on the [New] button on the toolbar. Select
[Schematic Design] from the [New] list and ensure that the Technology File entry is ' default.stf'. Click the
[OK] Button. Note that at this stage the effect of loading the Technology file has automatically set up all of
the Display colours, Maximum Resolution/ Working Area, working and screen grids, whether working in
Metric or Imperial units, the number of decimal places displayed on all co-ordinates, the standard sizes of
all text connection dots (Pads), line widths, the standard widths for busses and normal connections and
the names to be used for the standard Net Classes. - All with one keystroke!

Have a look through the [View] and [Settings] menu entries to see what has been set up. In the full
version of the program you can create different Technology Files for different requirements. A Technology
file can also be created from a design. This has the benefit that it can also contain the board outline and
all of the net names used in the design and the net classes that were assigned to them. These names
can be selected from a pick list in subsequent schematic designs dramatically reducing keyboard entry
required and also ensuring consistency throughout the design department. How many ways do you know
of naming Ground? Gnd, Ground, Common, 0v, 0V, Earth, Chassis etc.
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The automatic assignment of the net classes to the net names in the same way as in the originating
design ensures the standardisation of track widths and clearances for clock lines, data busses, power
rails, high voltage connections etc. over the product range,1RWKLQJ�LV�6HW�LQ�6WRQH��
Note that all of the parameters set up by Technology files can be changed at any stage throughout the
design process. Technology files are there to help you and speed the design process not manacle you or
restrict you.

6HOHFWLQJ�DQG�3ODFLQJ�&RPSRQHQWV
Click on the [Add Component] button on the toolbar. A library
selection dialog will appear. Drop down the list of available
libraries using the [Browse] button and choose 74LS.cml. You will
now see a dialog box listing all the components included in this
library. Select a 74LS00. Note that the PCB Package type is set
in the Add Component dialog. Hitting the arrow at the right of the
Package entry gives you the choice of either DIL (Dual In Line) or
SOL (Small Outline Surface Mount) PCB foot print. Press the
[Preview] button to show the component which will be added,
while still in the Add Component browser.

Press the [Add & Place] button and the dialog boxes disappear
and the four gates comprising the component appear in the
drawing area. Move the cursor to a convenient position and
notice how the four gates move with it. Now, click the left mouse
button to fix one of the gates in position. There are now just three
gates following the cursor around the screen. Place each of
these four gates in turn. Easy-PC assumes that you want to
continue placing more of the same type of component, so
another four “mobile” gates will appear at this point. Simply press
the right mouse button and select [Cancel].

Each of the gates can now be selected and moved individually.
Temporarily unused gates should be deposited anywhere out of
the current working area for use later on in the design. If
subsequently not used they should have their unused inputs tied appropriately to one of the power rails
for safety.

Repeat this process to add a couple more components from other libraries. If you put down discrete
components like a resistors or capacitors (R or C in the discrete.cml library), you can right click and select
[Values] [Add] to add and set the component's value(s).

0DNLQJ�&RQQHFWLRQV
The components are connected together by connections joining the
component pins. Click on the [Add Connection] toolbar button, then
simply click on a component pin to begin a connection. Click
anywhere on the drawing to put down a corner, and click on
another component pin to end a connection. Use the <F> (Flip) key
to toggle the XY to YX slope of the connection. Connections can
also begin and end on existing connections, forming “T” junctions.

Each connection can be given a Net Name and have a Net Class
allocated to it. In Select mode, single Right click on a connection or
part of a connection drops down the context sensitive menu which
has a [Properties] entry dialog. Selecting [Change Net] drops down
the [Net Name] and [Net Class] entry dialog. Type in the required
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net name (Or select an existing one from the Pick List) and either accept the Net Class entry or select an
alternative from the Net Class pick list.

Note that allocating net names and net classes is not mandatory, but if the schematic is subsequently to
be used with a simulator or the board layout is to be carried out by another person or autorouted then the
allocation of net names and Net classes at schematic stage will dramatically speed up the design
process.

Try dropping a Resistor on to a connection. See how the net is automatically split and that you are
reminded to re-name one of the split nets. (Select the net and use [Properties] [Change Net] [Net Name]
and check [Change Name of Subnet] only).

Becomes...

%XVVHV
Busses can be created, combined and split with impressive simplicity. Both Open and Closed busses are
supported with automatic net grouping, and bus terminal insertion on the busses, as well as the display of
net names. Busses can be drawn easily and shaped to meet most design standards.

Busses have not been specifically detailed here but are available for you to try in the evaluation version.

3ULQWLQJ�<RXU�6FKHPDWLF
At any stage you can output a print by selecting
[Output], followed by [Windows]. A typical Windows
printer dialog opens in which you can set up your
Windows default printer. Uncheck Plot Pins and Pin
Names/ Numbers to stop these from printing, if
required.  Essentially, Easy-PC For Windows
supports all Windows printer drivers even colour
printers, so we've provided an [All Colours Black] if
a black and white only plot is required.

The [Position Plot] button opens up a menu giving
you full control over the printing process including
centring it on the paper and scaling large schematics to fit the paper size.

[Current View] just prints the current screen. [Fit Plot] scales the drawing to make maximum use of the
Printer capability - rotating the print as appropriate.
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7UDQVODWLQJ�D�6FKHPDWLF�WR�D�3&%
Having designed the schematic OR, if you wish, you can load any of the supplied schematic examples
here. Select [File], [Open], and ' IVN�VFK
.
Now, drop down the [Tools] menu and select
[Translate to PCB].

The Translate to PCB menu gives you the choice of
using different Technology files for the translation and
hence the resulting Layout. These are displayed by
hitting the Pick List button immediately to the right of
the Technology file dialog. Note that the second
browse button is to enable the selection of the
technology file directory. The Library Directory must
point to the directory containing the supplied library
files.�6,*�3:5�SWI is a Technology file as an example for
Four Layer Boards with signal traces on the two
outside layers and two internal power and ground
plane layers.�6,*�3:5�SWI is a Technology file as an example for
Six Layer Boards with signal traces on the two outside layers and two internal power and ground plane
layers plus an additional two inner signal layers.'()$8/7�SWI is a fairly standard high-production-yield Technology file for relatively low cost Double
Sided Through Hole Plated Boards. This includes generous track widths and clearances.),1(/,1(�SWI�is an example Technology file for fairly high density fine line work as used surface mount
PCB's for example.0(75,&�SWI is a Technology file as an example for two Layer Boards but with units defined in Metric (all
other technology files are based on Imperial units).66,'('��SWI�is a Technology file for low cost Single Sided boards with very generous track and gap
widths.

We will finish the Schematic section here in 'mid-air' but the design process is continued now into PCB
design.

'HVLJQLQJ�,Q�7KH�3&%�'HVLJQ�(GLWRU
3&%�7HFKQRORJ\�)LOHV
Styles and Technology files work in many ways similar to Style Sheets in some Word Processors. Once
set up for a particular manufacturing process or group of similar end products, they can ensure
consistency of track widths, pad shapes and sizes, layer definitions and design clearances and, if
required, even net names.

The PCB Technology file has set up the layers used, the display colour allocated to those layers, the
autorouting bias for each electrical layer (for use with the autorouter), the maximum working area (and
hence the maximum resolution available), the display grid, the working grid, whether working in Metric or
Imperial units and the Precision (N

o
of Decimal Places), the Styles available for Pads, Text, Lines and

Tracks, The design rule spacings, and the Track Width and Via Pad Styles allocated to the Net Classes.$OO�ZLWK�RQH�NH\�VWURNH� This produces dramatic improvements in productivity for professional users and
minimises the learning curve for new users and light users.

Named Styles allow the user to set up sensibly recognisable Net Classes, track widths, pad types etc., for
use throughout a design. For Example track styles can be given names like Clock, Signal, 50 Ohm, 75
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Ohm, Low power, High voltage, etc., and the appropriate widths and any additional clearances set up for
them. Technology files and the Net Classes included in them allow sets of these pre-defined parameters
to be transferred between schematic and PCB and help ensure that the companies' standard board, track
and clearance requirements are used by the layout engineer.

Sample Technology Files are supplied for:-

Single Sided designs
Double sided Through Hole Plated designs
Fine Line Surface Mount
Four layer two power plane designs

On the full version of the program these can be edited and added to, as required.

Technology files can be created as new files, but can also be extracted from existing designs. These can
also include the net names and net classes from that design to ensure consistency across a range of
similar boards or products.

Continuing from the end of the Schematic section, where we left the Translate to PCB dialog waiting for a
technology selection, select ' GHIDXOW�SWI
, the standard Double Sided Through Hole Plated PCB
technology file and press the [OK] button. You may have already previously pressed the [OK] button, in
which case the display will look like this:

A new PCB window will open containing all the components in your design – now in their PCB forms –
connected together by direct connections. Components of similar types are stacked up in piles and all are
connected by the connections or nets defined in the schematic. It’s easy to see why designs at this stage
are often referred to as “Rat’s Nests”.

The components can be picked up and moved by clicking and dragging on any of their Pins (or Pads in
the case of surface mount components).

Zoom out a little and adjust the scroll bars until there is a clear area above the group of components, a
quicker way is to use the [View All] icon on the toolbar or simply press the <A> key.
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$GGLQJ�$�%RDUG�3URILOH
To add a board outline drop down the [Add] menu and select [Board] and [Rectangle], alternatively it is
quicker to select the [Add Board] icon from the toolbar. Position the cursor in the top left of the clear area
above the components. Hold down the left mouse button and drag the opposite corner until the rectangle
seems big enough to contain the components. Don’t worry about being too precise – it’s very easy to
make it larger or smaller later and to include corners, mitres or curves. Release the mouse button and a
board outline will be left on the screen.

Now, select each component in turn by clicking on any pad and drag it into the board outline. While a
component is selected, you can change its properties, including its angle and layer (for surface mount
devices), and which of its labels are displayed, by clicking the right mouse button to drop down a popup
menu. Drag all the components onto the board and adjust their orientations and positions until you are
happy with the result. The grid is set to 0.050" (50 Thou)
by default. All components placed will currently 'snap' to
this grid. You may wish to switch the display of the grid
off, press the <G> key to toggle it off (<G> will also
toggle it back on). Use the [Settings] [Grids] option to
change the placement (Working) grid to your own value
if required.

Your design could look like this example on the right >

Note how all of the connections or nets move with the
components ensuring that the connections defined in the
schematic remain true in the PCB. Easy-PC contains a
powerful Net Optimiser to tidy up all these connections
before we start to route them properly. The Net
Optimiser is called simply by dropping down the [Tools]
menu and selecting [Optimise Nets] and [All Nets].

The design is now ready for routing.

If you wish you can load 
ILUVWX�SFE
 at this point, this is
an unrouted example PCB file.

&RQYHUWLQJ�1HWV�WR�7UDFNV
Zoom in as appropriate and choose a rats nest connection that is relatively short and double click on it
near to one of the pads. This inserts a corner in the connection at the point where you clicked on it. Move
drag the corner (by dragging it) to a suitable position and single click to fix it in position. Continue clciking
to fix the next corner, and so on until the track is in the correct position. Use the right hand mouse button
to display the popup menu which will enable you to change the characteristics of the track segments
being added e.g. the track style and layer etc. If you change the layer, notice how the system
automatically inserts a via for you. Finally, double click to release the track.

If you accidentally start another track from the end of one of those previously routed, press the <ESC>
key on the keyboard.
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(GLWLQJ�7UDFNV
Editing existing tracks is all done by click and drag and double click and move. Click on a track segment
and move the mouse to drag it at right angles to its length. Double clicking on a track segment inserts a
new corner as we have already seen. Single clicking on a track corner selects the corner so that it can be
dragged to a new position. Double clicking on a corner converts in into a mitre (a 45° segment which cuts
off the corner) that can also be dragged into and out of the corner.

Track layers are changed by selecting a track segment and right clicking to display the popup menu.
Select layers and choose the new layer. Vias are added automatically
After a little practice you should be able to completely route a board like ' ILUVWX�SFE
�in around an hour.

(DV\�(GLWLQJ
The track, component and connection editing has been optimised to provide maximum productivity and
be very easy to learn. The ability to click and drag or double click and edit anywhere along a track,
connection, or on any object is smooth, intuitive and fast.
Note that PCB components are best selected by clicking on any of their pads (as nets and tracks are
always picked up preferentially).
Move a component and all of the tracks or connections move with it - sensibly.

(DV\�0LWUHV
Put a mitre in a right angle corner of a PCB Track simply by double clicking on the corner and moving the
cursor. Edit a mitre by double clicking on the mitre and dragging it as required. Right angle corners can
be mitred in a flash to shorten total track lengths and reduce reflections and radiation at high frequencies.
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(DV\�6KDSHV
Circles, Rectangles and Polygons, filled or unfilled can be added on any layer and added to any net
instantly. Shielding, Grounding and heat sink areas can be added in a flash. Circular and complex board
outlines and components can be created quickly.

(DV\�$QJOHV
Components can be rotated to any angle down to 0.1 degree either in fixed, user-defined steps or by a
specified angle.

(DV\�/LEUDU\�&RPSRQHQW�&UHDWLRQ
The component creation methods have been greatly simplified to minimise keyboard entry and maximise
ease of use.

$GGLQJ�&RSSHU�$UHDV
Copper shapes for Ground plane or heat sink areas can be added on any layer using [Add] [Shape] from
the menus. Complex shapes can be created using the Polygon option. The circle and rectangle options
produce fast results. These can be added on any layer, shapes on electrical layers can be added to nets
and are included in Design Rule and Connectivity checks. Shapes can be filled or unfilled.

3RZHU�3ODQHV
Internal Power and Ground planes can be added either at the Translate to PCB stage by using an
appropriate PCB Technology file (e.g. 2sig2pwr.ptf) or by adding the layers directly to the PCB, by using
the [Settings] [Layers] [Add] menu. Give the layer a name, set the Type to Electrical, the Side to Inner,
Bias to Power Plane, Usage to Electrical, and Net to the name of the net that you wish to connect to the
plane. This can be selected from the pick list. Power planes are not shown on the screen. Tracks can be
placed on power plane layers and they will be ploughed by the set clearance. Tracks on Power planes
dramatically increase the impedance of the plane and should be used only when absolutely necessary.
Thermal relief pads with set width and isolation gaps are produced at the post processing output stage of
the power and ground plane layers.

'HVLJQ�5XOH�&KHFN
You can check whether you have broken any design rule spacings using [Tools], [Design Rule Check].
This produces a printable report and marks the layout with the violations. After running DRC, pressing [T]
(for nex[T]) and [V] (for pre[V] ious) will take you forward and backward through the errors on the screen.
After correcting all of the errors (or altering the spacings), re running the DRC will clear the errors.

,QWHJULW\�&KHFN
[Tools] [Integrity Check] extracts the connectivity of the layout and compares it with the net list of the
schematic. Thereby ensuring that the PCB matches the schematic. It warns of any differences and
advises the changes required to bring the two into line.  This should be done using a corresponding
schematic and PCB design.

&RQQHFWLYLW\�&KHFN
[Tools] [Connectivity Check] provides a check that all of the nets are 100% routed and warns if a net is
split into two or more unconnected segments. [View], [Highlight Net] enables you to inspect appropriate
nets and make corrections.
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'HVLJQ�6WDWXV�5HSRUW
[Output] [Status Report] provides a summary of the whole board including Components used number of
drill holes etc. Have a look at the reports of some of the samples provided.

3&%�RQO\�'HVLJQV
Whilst most PCBs start life as a schematic design that has been translated, there are many occasion
where it is useful to work from a sketched schematic or even no schematic at all. This is no problem for
Easy-PC For windows - PCB designs can be created on-the-fly easily.

Simply select [File] [New], select an appropriate Technology file (if required), and place your components
and tracks as before. Track widths can be changed on the fly using right click [Style]. Track Layer can be
changed using right click [Layer]. Vias are inserted as necessary during routing.

Again, the board outline can be added using [Add Board] as can routing areas and additional free text.

,PSRUW�)URP�2WKHU�3URJUDPV
In addition to the standard import facilities for the DOS Versions of EASY-PC imports from other
programs will be available soon. - If you have any specific requests please contact us.  We can currently
load netlist from OrCAD Schematics and IMT EDA Workbench, again from a netlist.

3ULQWLQJ�/D\RXWV
This evaluation can print out schematics and layouts to any printer whose driver is installed in Windows.
There are no special drivers or setup, just use what is already available I your operating system. The full
version of the program can plot to HPGL pen plotters and generate Gerber and Excellon manufacturing
files.

Printing is started by
dropping down the [Output]
menu and selecting
[Windows]. The first dialog
displayed is used to select
the layers to be printed.
[Print Setup] is used to
adjust the printer settings,
while [Position Plot] sets up
the positioning and scaling of
the design on the printed
page. Checking the [Fit Plot]
checkbox will ensure that the
design is scaled and, if
necessary rotated, to the
maximum size that will fit on
the page.  This gives you
maximum flexibility to print
the area of the design or
position the print exactly as you require it on the paper.

If you are sending the output to a colour printer, the colours of all elements will match those displayed on
the screen. To change the colours use the [View] [Display] option, or for check prints you can also choose
to make all the colour to black during printing by selecting the [All Colours To Back] option.
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*HQHUDWLQJ�0DQXIDFWXULQJ�)LOHV
This is inhibited on the evaluation version of the software. Easy-PC For Windows supports formats for the
following:

HP-GL pen plotters
Gerber RS-274-D photo plotters
Gerber RS-274-X photo plotters which includes the embedded aperture data
Excellon NC Drill machine for drilling the boards
Windows printers drivers
DXF (AutoCAD format) files for connection to mechanical CAD packages

Output files can be generated for all aspects of the manufacturing process including, check plots,
artworks, drill drawings, photo plots, NC drill files, silk screen, assembly drawings and board build
drawings.3OHDVH�FRQWDFW�1XPEHU�2QH�6\VWHPV�IRU�VDPSOH�ILOHV��LI�UHTXLUHG�RU�IRU�PRUH�GHWDLOHG�LQIRUPDWLRQ�
(DV\�3&�+HOS
If you need more detailed information on any of the
functions offered by Easy-PC, simply select [Help]
from the main menu, or press the <F1> key on the
keyboard. You can either select a topic by double
clicking it in the [Contents] tab, or search for a topic
by typing the first few letters of a keyword in the
[Index] tab.

([SORUH�IRU�<RXUVHOI
Now that we have taken you through the design
process from schematic to PCB, it is time for you to
carry on exploring the facilities of this program on
your own. As save is inhibited, you will not change
permanently any of the sample files provided or your
own designs if you are a previous user of the DOS
versions of EASY-PC.

7HFKQLFDO�6XSSRUW
For more detailed reference information on menu entries, etc. we recommend that you use the on-line
Help system accessible via the [Help] menu on the main menu bar, or by pressing the <F1> key on the
keyboard.
If you have any problems installing or running this program, you can contact your dealer or our Technical
Support department by telephone on +44 (0)1480 382538, by fax on +44 (0)1684 773 664, or by e-mail to
support@numberone.com.

+RZ�7R�%X\�7KH�)XOO�3URJUDPV
Now that you've decided you like the program and want to buy it, how do you do this?

To obtain one of the fully enabled versions of Easy-PC For Windows, complete with a printed manual, full
libraries and the ability to generate industry-standard manufacturing files, contact us at our International
Office on +44 (0)1684 773 662 or by fax on +44 (0)1684 773 664

We can provide you with a price quote or Proforma invoice if one is required. Check out our new prices
on the Number One Systems web site www.numberone.com , prices are the lowest they've been for years
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including upgrades and competitive cross-grades. These new prices combined with new product variants
make Easy-PC For Windows an affordable professional choice.

&RPSHWLWLYH�8SJUDGHV
Special competitive upgrade discounts are available if you are transferring from the use of a product from
another supplier. Please contact us for an attractive price quotation.

2YHU��������/LFHQFHV�6ROG�
Number One Systems has sold in access of 45,000 licences over the last 20 years into over 100
countries. The list of companies using one of our products is increasing all the time. With major company
representation world-wide owning at least one licence from Number One Systems, our product portfolio is
an integral part of the EDA and electronics CAD community in all facets of the electronics business be
they large or small, professional or occasional users.

:HE�6LWH�$FFHVVZZZ�QXPEHURQH�FRP
Our web site keeps you fully up-to-date with current developments and new product information. The site
is fully accessible and not restricted in any way, please feel free to visit and browse at any time. Also
remember, that an off-line version of the web site is supplied on the evaluation CD-ROM of the software
but will only be current on the day of the cut of our CD-ROM, there may be more current information on
the live web site. Our web address is: http://www.numberone.com

Evaluation versions of our simulators and other products can be downloaded from our Web site at the
address above or obtained direct from our sales offices or dealers.

:KR�$UH�:HVW'HY�/WG�"
WestDev are a software development company based at Bredon near Tewkesbury, Gloucestershire, in
the UK. The team at WestDev boasts over 140 man years software development experience. Our aim at
WestDev is to bring you outstanding value for money and realistically priced, power-packed products long
into the future.

Although WestDev Ltd. wrote and owned the Easy-PC For Windows product they purchased the
intellectual property rights to all of Number One Systems product at the end of 1998 and have since been
marketing, selling, supporting and developing the complete product range from their own premises under
the Number One Systems trading name.

We can be reached at the following address:

Number One Systems
Oak Lane
Bredon
Tewkesbury
Glos GL20 7LR
UK

Tel: +44 (0)1684 773 662 Email: info@numberone.com
Fax: +44 (0)1684 773 664 web site: www.numberone.com

Copyright (C) 2001 WestDev Ltd. All rights reserved.

Number One Systems, EASY-PC, Easy-PC, Pulsar, Layan, Analyser, Multirouter, Filtech, Z-Match, StockIt,
StockWin, Easy-Router and all variants thereof are Trademarks of WestDev Ltd.
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All other trademarks acknowledged to their rightful owners.  E&OE


